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Taming the Beast Part I: 
General Hardware Facts 
 
The “on/off” switch is in the lower left hand corner of the machine.  To use the machine, it must 
be on.  To fix any/every major problem that you encounter, turn the machine off.  To use it again 
after fixing problem, turn the machine back on.   
NOTE: Each time the machine is turned on it will need a short amount of time (around a minute) 
to recalibrate itself.  The Varian Representative who installed this machine recommended it be 
on for at least 15 minutes each time it was turned on, but claimed that less was “OK”.  My own 
personal experience indicates to me that the machine will have fewer errors if left on for 15 
minutes.   
 
There are two lamps in the machine, a Visual Lamp and a UV lamp.  The UV lamp is a 
deuterium lamp.  Bulbs for the visual lamp can be stocked, but it is recommended that the 
deuterium bulbs are only ordered when they are needed.  They should come within a couple 
business days.  The range of the UV lamp is approximately 1900-4000 Angstroms, while the 
range of the visual bulb is approximately 3500-9000 Angstroms.  (Though Phillips makes the 
bulbs for Varian, and Bulbs Direct reportedly has a 3000 Angstrom cut off) 
 
The visual lamp should be replaced every 6 months or so, and the UV lamp should be replaced 
approximately every year, in a heavy workload environment.  There are complete instructions 
and video help for replacing bulbs using the help videos.   

 
Figure 1: picture of the Cary 100, with 
monitor for computer controlling it sitting on 
top. 
The part shown in the foreground I will refer 
to as the “front”, “left” is to the left in this 
picture, “right is to the right, and “rear” is 
the direction towards the back of the machine.  
The rear left teal in this picture is the cover 
over the compartment where the lamps are, 
the bulge in the front is the large front door, 
and the teal in the front center is the cover.   
 

 
 
 
 
 
Figure 2: The on/off switch



3 

Taming the Beast Part II: 
Dealing with the Computer 
 
The machine must be run using a computer.  It is (as of June-August of 2004) a Windows 
machine, running Windows XP.  It is hooked up to the McDonald Observatory network and is 
called “Medusa”.  Medusa does have internet access.  To turn on the computer, hit the circular 
power button on the lower front face of the tower.  The monitor should have an orange light to 
the power button on its lower right corner while the tower is off, but if it doesn’t, then push that 
button, as well.  The backlight to that button will be green with the monitor is on and working 
with the tower.   
An error message will appear.  Click the ok button, it just means that a Varian machine is 
attached to the computer and that the software is installed.   
 
There is an icon for Cary WinUV on the left-hand side of the desktop.  You can get to any 
application you wish to (including the help) by double-clicking on this.   
 
The application that we will use the most often is “Scan.”  The basic idea of scan is that in the 
setup you specify the range (which must ALWAYS be specified from high number to low 
number) of wavelengths to go through, the step size, and the amount of time spent on each step.  
More on this later. (in the parts about individual accessories) 
You should perform a baseline (by clicking on the “baseline” button) after setting up your 
scanning parameters and before actually doing your scans.  This is performed without any 
samples present, so that the software can ignore the information from the machine’s properties.  
More on this later, too.   
 
NOTE: Whenever you are taking readings, it is NECESSARY that the top cover pulled out so 
that it is against the door.  The ideal situation involves no light leaking in to the interior cavity 
with the accessory and sample.  
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Taming the Beast Part III: 
Accessories to the Machine 
 
Without accessories, there isn’t really anything that we can do with this machine.  With 
accessories, we can get the relativity for witness samples to verify that the mirror is a good one, 
get the transmission band for filters, and get scattering information for witness samples.   
NOTE: During each accessory change it is recommended that you turn off the machine. 
 
Accessory the First: The Specular Reflectance or V/W Accessory 
 
  a                         b  
                                                                                                                          horizontal            
                                                                                                                                 peg  
 
 
 
 
 
 
 
 
                                                                                                                                                                  clip 
 
Figure 3: The Specular Reflectance Accessory as it should be stored (except with the box open and unlatched) 
(a), and sitting on a chair (b). 
 
This accessory is used for getting the absolute value for reflectivity of the sample.  It’s relatively 
simple to install, use, and uninstall.     
WARNING: Do not turn upside-down and/or shake accessory, you will probably break it if you 
do so.   
It is stored in the larger wooden box.  To install it in the machine, first uninstall whatever 
accessory is currently in the machine.  Take the door off and slide back the cover.  Place two 
black flathead screws in the back two holes in the interior cavity, and the silver placement pin in 
the front left hole.  Tighten the silver placement pin, but do not tighten the screws at all.  Take 
the accessory out of its box and out of its bag.  The large flat part I will be calling the base (as 
shown on the bottom in Fig. 3), and the boxy portion I will be calling the box.  Place right side 
up (with the base on the bottom) into the cavity, with the slots in the base (on the left in Fig. 3b) 
towards the rear and the two horizontal silver pegs extending from the box of the accessory 
pointing toward the front.  Slide into cavity so that the two flat head screws fit into slots and the 
silver pin fits into the hole, which is now just to the front and on the left corner of the box.  
Tighten down the screws.   
You should be able to wobble it a bit, from the front, even after screws have been tightened.  The 
base extends past the front of the machine, so you have to use the large door.  (different doors are 
detailed in Part IV: Other Parts)   
 Within the box there are three mirrors, as you can see in Fig. 4a.  They are internal optics, 
and will need to be accounted for when determining the reflectance of the mirror you are testing.  
In Fig. 3b the clip for holding the sample to the front surface of the box is pictured as being 
attached.  (The clip is also pictured holding the mirror to the box in Fig. 4a.)  There is currently 
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an extra clip (as well as a couple other small pieces of equipment) being stored underneath the 
accessory itself in its storage box.   
 
 
 
 
 
 
 
 
 
 
 
 
 a        b  
 
Figure 4: A close front view, noticing the three mirrors inside the box, as can be seen through the long hole in 
the front (a), and a top view when the mirrors are set up properly to take the baseline (b).   
 
 The most frequent use (the only one we are currently intending, actually) will be to use 
the Scan application with this accessory to find the percent reflectivity over a portion of the 
spectrum, keeping within the range of the two lamps.  The wavelengths can be set in the first 
page of the setup in the Scan application.    
 To open the Scan application, either double-click on the saved method that you plan to 
use or open it from the Cary WinUV folder on the desktop.  Make sure that the setup is what you 
want it to be, in either case, by single-clicking on the “Setup…” button in the frame on the left 
side of the screen.  When you are done making sure that it is the way you’d like it, you’ll need to 
get a baseline, if you have it set for baseline correction, which is appropriate for this accessory. 
 The method to getting a baseline with this accessory is rather simple.  The middle mirror 
is not actually attached to the base or the box, but rather attached to a stand.  To get the baseline, 
first take the mirror out of the box by lifting up on the horizontal black peg above the center 
mirror (which you can see in Fig. 3b).  The next step is to properly position it outside of the box.  
Rotate the mirror on its stand 180º around the front of the box, so that it is facing the opposite 
direction, but still right side up.  The vertical pins on the front part of the base should go through 
the holes, and the mirror should sit rather steadily in that position (see Fig. 4b).  Attach the large 
door and slide the cover forward until it stops against the door.  Single-click on the “Baseline” 
button, and the computer will prompt you to “Insert a blank sample…”, which you did when you 
switched the center mirror around, so click “OK”, and it will take a baseline.  If the baseline 
looks terribly strange, you may want to turn the machine off and back on.  If you cannot click on 
the baseline button, make sure that you are in the active window controlling the machine (the 
buttons at the top of the window say “Start” and “Stop”/neither of them say “Connect”), that the 
machine is on, and that the machine is not taking any other scans.  If you have the “Setup…” set 
to using both the UV and Visual lamps then you will hear the switchover.  You will know that 
the baseline is done when the graph stops drawing (if the axes are set up so that the far left side is 
the lower bound of your scan), when the stop button becomes unusable, or when the text in the 
bottom left corner of the window reads “Idle”.  Really, it’s done with all three, but you may only 
notice one.  To stop the baseline before it completes, click on the “Stop” button.  DO NOT 
OPEN THE TOP UNTIL THE BASELINE IS COMPLETED!  After it is done, look at the 
graph.  There should be ONE discontinuity.  If there is more than one, redo the baseline.  (see 
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Fig. 12 and the paragraph about baselines in Part V)  If you drop or otherwise damage the central 
mirror and its holder, you will need to align it.  Using the Align function and rotating the bolts 
should fix the problem.   
 After you have your baseline, reposition the middle mirror as it was before you took the 
baseline.  Now you are ready to take a reading.   
 Take the mirror sample and place it, firmly but gently, on the front vertical surface of the 
box.  The sample MUST cover the small hole in the middle of that surface entirely.  (See Fig. 4a)  
Failure to do so will result in an incorrect scan.  Slide the metal clip into position so that it will 
hold the sample in place.  Be cautious to not touch the reflecting surface of the mirror, as 
sometimes you have to handle the mirror quite a bit to get it into the correct position.   
 Reattach the door, and close to top.  Hit the “start” button (at the top of the window).  
You may be prompted to save the scan.  The last two pages of the “Setup…” menu set up how 
the data will be saved.  Once you have given it a name and a file type, click the “Save” button.  It 
will then ask you what you would like to call this scan.  For both of these names, if you end the 
name with a number, it will automatically increment the number for the next scan, so putting the 
date at the end of the name is a bad idea.  DO NOT OPEN THE TOP UNTIL THE SCAN IS 
COMPLETED!  If you hit the “stop” button, the scan will ask if you really want it to stop, and 
then will stop if you reply that you would like it to stop.  You can tell that the read is finished 
when the graph is done being plotted, or by any of the other indications that you can tell the 
baseline is done.  Look at the graph.  If it has any features that look like they are direct results of 
errors in the baseline (there is an unexpected peak where there is an unexpected valley in the 
baseline), then you’ll want to restart the machine, possibly the computer as well, and start with a 
new baseline.  Just taking a new baseline and a new read will not help anything.  It will give you 
the same results.  (See Fig. 12 for what is acceptable and what is not.)   
 Now that you have the results of your scan, what do they mean?  Nothing.  The scan is 
from a double bounce off of the sample mirror, not a single bounce, as happens with the actual 
telescope mirrors.  So the numbers on the graph (and in the list, if you chose that option in the 
“Setup…”) mean nothing useful.  There are a couple of methods to looking at real reflectivities.   
 You can use Excel, or you can use the Cary software.  Excel is a bit more work, but will 
display more than one of the square-root graphs, while the Cary software will only display one 
analyzed trace per graph.  To use Excel, hide all of the data besides the traces that you would like 
to be in your spreadsheet using the “Trace Preferences” window.  Then go to File>Save As.., and 
save the file as a .CSV (comma delimited) file.  You can then go to the folder which you saved it 
in and open it using Excel.  If you perform any operations on the data (such as square rooting the 
y values and multiplying that result by 10 to get the actual reflectivity), you will need to save it 
with a different file extension, such as .xls.   
 To use the Cary software you select a trace (by either clicking on the trace itself or 
opening the trace preferences window and clicking on that trace’s color column), and enter the 
calculator menu.  Click on “selected trace” or “focused trace” and then click on “square root”.  
Next, click on the * and then click on the 1 and 0, to multiply by ten and get numbers for %R.  
Clicking on “=” will either draw a new graph with the actual reflectivity (if you have “new 
graph” selected) or create a new trace in the trace preferences menu (if you have “selected 
graph” selected).  If you create it in selected graph, you will get an error if you do not have a 
graph selected.  To remedy that, click on a graph and then hit “=” again.  The new trace will 
appear in the trace preferences menu both ways and you can choose to display it on any graph, 
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delete it, change its name, or change its color by clicking on its name, and then right clicking on 
its name.       
 If you would like the actual reflectivity of the average of a few traces, you can also use 
the calculator.  For each trace: select the trace, click on the “selected trace” button, click on the 
“/” button, and click on the number button that is the number of traces you are averaging.  
Between each trace (not after the last one or before the first one) click on the “+” button.  When 
you click on the “=” button a new trace on a new graph will be written, or a new trace appearing 
in the trace preferences menu, depending on whether  you have “selected graph” or “new graph” 
selected.  To get the actual reflectivity from the average, follow the same steps that you would to 
get the actual reflectivity of any other trace.   
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Accessory the Second: Diffuse Reflectance Accessory (external): 
The two most important things to remember about this accessory are to “zero” the item 
before taking a reading (either a baseline or a sample reading), and to turn off the machine 
while installing and while uninstalling the 
accessory.    

    Figure 5:  Top view (right) 
and frontal view (left) of the Diffuse Reflectance Accessory (external), as well as 
wedge with angled end of tube facing it (middle). 

 
 To install, include only the silver placement pin.  Remove anything in any of the other 
holes.  This accessory should be stored in a sealed plastic bag to help slow the decay of the white 
inner coating.  The Help file on this accessory is completely unhelpful.  YOU MUST TURN 
OFF THE CARY TO INSTALL THIS ACCESSORY!!!!  If you don't do this, there is a very 
high likelihood of bad things involving needing to replace at least the accessory happening.   
 Orient the accessory so that the mirrors are toward the rear and the box-like structure is 
toward the front.  There is a cord sticking out the bottom.  Plug that in to the plug in the 
depression in the central cavity. (Fig. 6b)  The plug is on the front wall of the depression.  There 
are two screws to secure the accessory to the machine, one in the front right of the base, one in 
the rear left of the base.  You can turn on the machine again after you have plugged in the 
accessory.   
Use "double beam" mode, just like all of the other accessories, the machine will read what it is 
supposed to do from the accessory's plug.   
 There are a few accessories to this accessory.  There are certified reflectance standards, 
a wedge of zero degrees, a wedge of eight degrees, and a clip.  To do measurements of mirrors’ 
diffuse reflectance and scattered light do not use the certified reflectance standards.  If you do 
need to use them, they are in a wooden box labeled “Certified Reflectance Standards.”  The zero 
degree wedge (which means it is flat) is used for measuring the scattered light, and the eight 
degree wedge is used for measuring diffuse reflectance.  The clip is used for holding samples in 
place for both.   
 You will want to use baseline correction for this accessory.  To take the baseline you 
need to use something that will not be part of the reading for your sample.  This means that your 
sample’s data will not be absolute but will be relative to whatever you used to take the baseline.  
(The software will assign a value of 100% to each value that it reads for the baseline, and have 
your reads based off of that assumption.)  Since you are scanning mirrors it is best to use another 
mirror.  The certified reflectance standards would be used for this purpose, but since we are 
measuring mirrors the data looks strange when you use the standards for the baseline.  Try to use 
the same or a very similar mirror for all of your baselines, and your data will be able to be 
compared against itself or other data.   
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 The procedure for taking a baseline is the same as that for taking a sample’s data 
(almost), and both are the same for both measuring scattered light and for measuring diffuse 
reflectance.  First, slide the wedge in place, the 0° for scattered light and the 8° diffuse 
reflectance.  (Fig. 6a)  The notch at one end slides on the horizontal rail at the front of the box.  
The side with the white coated indentation around the hole is the side that faces the box.  The 
clip also has a notch, and also needs to slide on the rail.  Since the clip is to hold samples firmly 
against the wedge, there are springs that force the clip to bend towards the wedge.  Straighten 
(against the springs) the clip so that the notch is at the bottom and the clip is straight up from 
that.  Then slide the clip along the horizontal bar to attach it.  (The two knobs that the short tube 
on the clip rotates around should be pointing towards the box.)  The short tube that rotates inside 
the clip is the part that will actually secure the sample (or the item for taking the baseline) to the 
wedge.  For the zero degree wedge you will want the flat end of the tube to point towards the 
wedge, and for the eight degree wedge you will want the angled end of the tube to point towards 
the wedge.  When there is no sample, if you have the tube positioned correctly, the tube should 
rest against the wedge without any noticeable gap, when the clip is close enough to the wedge 
that the top edge of the flat part of the clip is not resting against the wedge.     
 To take a baseline, place the item you’ll be using for the baseline so that it covers the 
hole in the wedge.  Secure in place with the clip.  Replace the door and close the top.  Either door 
can be used.  Click on the “zero” button, and wait until you can click on other buttons.  Click on 
the baseline button, and then click on “ok.”  When it is done, remove the item you used for the 
baseline.   
 To take a reading on a sample, place the item against the wedge so that it covers the hole.  
Secure in place with the clip.  Replace the door and close the top.  Either door can be used.  Click 
on the “zero” button, and wait until you can click on other buttons.  Click on the “Start” button.  
If you have the option where it asks you what to save it as, decide on a name and click “save”.  
Name the trace something that will make sense to you for the trace name.  Click “ok”.  If you 
had the option selected where it would prompt you to save after the scan, decide on a name to 
save it as and click “save” when the window pops up.   
 To save a number of scans and the baseline in the same file, save after you are done with 
them.  Then go to File > Save as…, and save as a .bsw file.  This will only save all of the visible 
traces.  Make sure you have all of the traces that you would like saved visible and all of the 
traces that you do not want either deleted or hidden.  (You can hide or show a trace in the trace 
preferences menu by clicking on the trace name and then right clicking on it.) 
   a 
    Figure 6: The 8 degree wedge on the left, and the 0 degree 
 wedge on the right (a).  The sides facing up in this picture 
 would be the sides facing towards the rear for readings.  
 Only use one wedge (either the 0 degree or the 8 degree) 
 for each reading.  You need to use the same wedge for your 
 baseline as for you reading.  Where the cord plugs in (b) 
   
 
 
 
 
 
 b     
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Accessory the Third: The 45° Angle Bounce Accessory 
 
 
  
 
 
 
 
 
 
 
 
 
Figure 7: Base with screw bag (a) and box/tube being inserted into holder after base is screwed into the Cary 
(b).   
 
This accessory consists of a black box-like tube and a base with a holder for the box.  (Fig. 7b)  
There are four holes in the base, so you need four screws to hold it in place.  The screws to use 
are kept in a plastic zip bag with the ends tucked into the holes in the base.  (Fig. 7a)  These 
screws have more length than the (regular) flathead screws, and also are not flatheads.  The box-
like tube is kept in a smaller darker colored wooden box.  There are three pieces of light 
cardboard taped to the holes in the tube.  Also kept in the box are two plastic tubes.  In one tube 
are several washers (apertures), and in the other (which is labeled “alignment mirror”) is a small 
mirror.  It is supposed to be of the same quality as the mirrors in all of the other Cary optics, but 
even the first time I opened that tube after the machine was installed the mirror was scratched 
and had a fingerprint on it.   
 Remove the tape and cardboards from the holes.  Set them aside, it’s nice to keep them 
covering the holes during storage.  At one end of the tube there is a rectangular opening, and at 
the other end there is a piece that sticks out with a circular opening.  The part that sticks out (and 
has a screw at one side of the top) is the part that slides into the holder.  I believe that you can 
make the screw longer to make the tube sit higher, which would be to improve alignment.  The 
screws opposing each other on the sides of the holder can be adjusted to move the tube from side 
to side in the holder (towards the front and towards the rear), and can also be used to secure the 
tube-like part in place.   
 There are two mirrors inside of the tube.  Light comes in from the left, bounces off of one 
mirrors, performs a 45° angle bounce off of a reflective surface that covers the hole in the top, 
bounces off of the second mirror, and then goes out the opening at the other end.  It will then 
enter the hole in the central cavity of the machine’s wall if the accessory is aligned correctly.  
You may want to use the Align function to be sure of this.  You can find the Align function in 
the Cary WinUV folder on the desktop.  When it has loaded, go to the Commands tab at the top, 
and scroll down to Align.  Select it, and a pop up will say that the light is being driven to the 
visible for alignment, and that you should click OK when it you would like it to resume the 
previous wavelength.  You’ll want to do this when you have the tube already in place.  You can 
use a piece of paper to check to see that the light is hitting the spot on the cavity wall where the 
hole is.   
 Once you have your alignment correct, you should be able to start the process of taking 
readings from your reflective surface(s).  As with the other three accessories it is most useful to 
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use the “Scan” function for taking the data, as it will get the reflectivity across a portion of the 
spectrum, up to from 1900 to 9000 Angstroms.  Use the “Setup” button to open the Setup 
window.  Change the values to be the setup that you would like to use.  You WILL want to use a 
baseline.  This is a very important point.   
 Unlike the V/W reflectance and the transmission accessories, but like the diffuse 
reflectance accessory, you will need to use some other reflective surface that is NOT included in 
the optics of the machine during the readings.  You could use the alignment mirror or some other 
mirror that is in reasonably good condition for the baseline for mirrors, because it is generally a 
good idea to compare the reflectance with a baseline that was taken of something that is similar 
to what you are taking the reading of.  The most important part of taking the baseline:  You 
MUST use the same aperture for the baseline that you are using for the reading(s).   
 What are the apertures for?  They fit snugly (only using one at a time) over the hole in the 
top of the box/tube, and effectively reduce the size of that hole.  You should use one if anything 
you are scanning (either the things you would like readings on or the object you are using for 
your baseline) is too small to completely cover the hole, or if you would like to have your scans 
of a smaller area of the mirror.  Since the object you use for the baseline is not a part of the 
optics of the machine when you take the readings, it is important to remember that all readings 
are relative to the baseline.  (Fig. 8) 
 You will not need to do anything to the graph to get more usable data, unless you can 
find the actual 45 degree bounce reflectivity of your baseline.  If you can find that, then you will 
need to multiply your reflectivities (in their decimal form, where 100%=1.00) by it (in decimal 
form, where 100%=1.00) to get the actual 45 degree bounce reflectivities.   

 
 
Figure 8: Assembled accessory with aperture.   
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Accessory the Fourth: For Measuring Transmittance 
 
 
 
 
 
 
 
 
 
 
 
  
 
Figure 9: Accessory in place with filter in sample holder in appropriate slot (a), empty sample holder in 
appropriate slot for baseline (b). 
 
This accessory is the only accessory that we have for measuring transmittance.  It has a base and 
three vertical rows with slots.  It is not stored in anything, currently.  There are a few accessories 
for this accessory: a polarizer, a depolarizer, and two sample holders.  To attach this accessory to 
the machine, you need three flat head screws and the silver placement pin.  The silver placement 
pin is screwed in in the front left hole in the machine, and two flathead screws are placed in the 
rear two holes.  Slide the slots in the back of the accessory (the small two that are cut out of the 
base) in to fit around the two screws.  If you lower the front end, the silvered hole should fit over 
the silver placement pin.  Place the last screw in the hole in the front right of the base, and it 
should fit into the 4th screw hole in the machine.  Tighten down the screws.   
 The light beams enter from the left side of the cavity and exit through the right side of the 
cavity.  If you would like to use the polarizer and depolarizer, they are stored in little white 
plastic tubs that resemble baby wipe tubs.  If you would like to test the transmittance of polarized 
light, use the polarizer in the left slot, the sample in the middle slot (the sample will always go in 
the middle slot), and the depolarizer in the left slot.  The sample holder can be taken out of its 
slot if desired.  It lifts out.  To use the sample holder, place the sample in so that the light beam 
will hit the part that you want to test the transmittance through, and firmly secure in place with 
the white clip.  (To verify that the light beam will be only located where your sample is, you may 
want to use the “Align” tool.  A shortcut to it is located in the Cary WinUV folder.  Open it, 
make it the active tool by clicking “Connect” if there is a large “Connect” button at the top of the 
Align screen, and look for the commands drop down menu.  In that menu go to “Align”, and 
select that.  A dialogue box will pop up, you will not want to hit “OK” until you are done with 
this task.  The machine will be driven into the visible, and if you put something up where you are 
going to have your sample (perhaps even your sample in its holder into the slot), and then you 
should see a beam of white light hitting it.  If the white light hits somewhere where your sample 
isn’t, you’ll want to reposition your sample.  If the white light hits such that it won’t pass through 
the hole in the sample holder or the hole in the right side of the cavity, you’ll probably want to 
align the lamps.  Use the help files on doing that.  Once you have verified that your sample is in 
a good position then hit the “OK” in the dialogue box.  Close out of the Align tool, don’t save 
anything unless you had to realign the lamps.) 



13 

 This is another accessory that will be making use of a baseline (for the scan function).  
The “Y mode” (selected in the first page of the “Setup…” menu) will be %T.    The option to use 
baseline correction is on the “Baseline” page of the setup.  There IS a method saved as “General 
Transmission” that will have a range 2000-9000Ǻ, data point every 10Ǻ, with the machine 
spending 0.1 seconds on each point.  It has “Auto Store” off, but the program will still prompt 
you to save.  I’m not sure why that is.  The method also has baseline correction selected.   
 To get readings the first thing you will need will be a baseline.  To get a baseline, set up 
the instrument in the exact same way you will be taking readings, but don’t put the sample into 
the sample holder.  A way that I found is more convenient is to use one sample holder in the 
front slot and to leave the back slot empty (in the middle row, where the sample holders usually 
sit during storage and for readings).  Use one sample holder for getting the baseline (just leave it 
empty) and use the other to hold the samples.  That way if you would like to change the range or 
resolution of the scan but scan the same sample, you only have to put the sample into a sample 
holder once, rather than taking it out and putting it back in.  (NOTE: if the range changes so that 
you are scanning across a smaller margin of wavelengths, it will not make you take another 
baseline, but it is a good idea to do so if you are using a different resolution from what you were 
originally using.)  After making everything almost exactly what your scan will be but without 
your sample (this means that you should include the polarizer and depolarizer if you’re using 
them), click on the “baseline” button, and it will prompt you to “Insert the 100%...”, click ok.  Of 
course, the door should be on (it can be the smaller door), and the lid should be closed.  
Otherwise the baseline will be strange, which will result in your reading being strange.  After the 
baseline is done reading (the Status (shown in the lower left hand corner) will say “Idle” and the 
Start Button will be clickable again), put the sample in.  Click on the “Start” button.  (Fig. 9b) 

If you have Auto-Store on (or even if you don’t, sometimes), it will prompt you to 
specify where to save the file.  This file Then it will prompt you to name the curve (as it does for 
all accessories, so long as you are using “Scan”), and then start the reading.  (Fig. 9a) 
 The output will be a graph, but the saved file will be of the type you specified.  “.csv” 
files are spreadsheets, and can be opened in Excel.  “.dat” files are data files, and can be opened 
using the Cary software.  You will see what was displayed when you made your scan.  These are 
the two types I use.  If you save after you are done with your scans, save either as a “.bsw” file 
(batch), which will save every data line that you have selected in the “Trace Preferences” menu 
as it appeared when you took the data using the Cary software, or as a “.csv” file, which will 
save a list of all of the data lines that you have selected in the “Trace Preferences” menu.  If you 
would like to only save the graph, right click on the graph and select “Copy Graph”.  You can 
paste it into whatever you would like, but if you use Microsoft Paint you can save it as a bitmap, 
jpeg, or gif image.  If you would like the graph to have gridlines, you can use the “Graph 
Preferences” menu.  If you would like to take multiple reads on the filter in different positions, 
just change the position of the filter (by flipping or rotating it), but keep it so that the light only 
goes through the filter, and doesn’t go around.  If it wants you to save the file, it will 
automatically increment the name that you last saved, so if you saved Filter017, it will next try to 
save Filter018.  If you saved it as something ending in a letter, it will try to save as that exact 
thing, appending a “1” to the end.  You can save as whatever you would like to save as.  The 
trace names start out as sample1 (unless you change it), and increment themselves.  It is often a 
good idea to use trace names that you will remember the meaning of, though.   
 You can also save a baseline, if you believe that the machine will be relatively uniform in 
its baseline.  It was promised to be, but I don’t trust that, personally.   
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 OK, so you’ve scanned a filter.  Presumably you’d like to find out some facts about it.  
You can use the “Peak Labels” menu to show the maximum transmission’s wavelength and the 
maximum transmission, but how do you find the central wavelength and the full width at half 
maximum of the transmission curve?  (Another side note is that when you use the peak labels for 
transmittance, selecting “valleys” labels peaks, and selecting “peaks” labels valleys.)  If you save 
the scan as a .csv file, you can open it using Excel, as previously mentioned.  If you want to save 
the list as something else (a webpage, for example), do that before you do the following actions.  
After you have done the following actions, do not save unless you save as a different filename.    
When you open it in Excel, click somewhere in the %T column.  Select “sort descending” from 
the list of tools (if you don’t know what it looks like, ask the office assistant about “sort 
descending”.  Then click on “sort a list”, and then click on “Sort rows in ascending order (A to Z, 
or 0 to 9) or descending order (Z to A, or 9 to 0).”  You want to sort in descending order.  The 
wavelengths corresponding to the %T’s should stay with the correct %T.  The top row should 
contain the maximum transmission and the wavelength that goes with it. Divide the value of the 
maximum transmission by two.  Then scroll down the list to look for the closest values of %T to 
that quotient.  Make sure that one value for the wavelength is less than the peak wavelength 
value, and that one is greater than the peak wavelength.  Take the difference of the two 
wavelengths (corresponding to the two values of %T that best approximate half of the maximum 
%T and are on either side of the curve) to get the Full Width at Half Maximum.  Take the 
arithmetic average of the two values to get the central wavelength.   
 If you would like to make a webpage using these values, there is a template that you 
should look at with instructions saved on the computer, or you could set up one on your own.    
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Taming the Beast Part IV: 
Other Parts 
 
Other parts have been mentioned without having been gone to in too much detail.  Here are a few 
of them: 
 
Doors 
The machine comes with two doors: a small one (which is flat), and a large one that resembles a 
box missing around one and a half sides.  The small door is easier to attach and remove, but the 
large one has to be used from time to time.   
To attach the small door, put the two knobs into the notches at the front of the machine.  Allow 
door to swing closed.  Magnets hold the door shut.   
To attach the large door, line the pegs on the door up with the holes in the front of the machine.  
Push them in, and, gently but firmly, push down on the door.  If you try to pull the door off using 
only horizontal motion, if it comes off then you either didn’t get both pegs in, or you didn’t push 
down well enough.   
To remove the small door lift up and away.   
To remove the large door push/pull the door up and take horizontally away from the machine.  
(After lifting the door up, it should be relatively easy to pull the door horizontally away).   
NOTE: When attaching/removing doors, always slide the top cover in first.   
      a            b           
 
 
           holes for attaching    c 
      large door 
                                                 Peg      
                                                 In Slot 
 
 
 
 
Figure 10: With the small door (a), with no door (b) (but with the silver placement peg attached in the front 
left screw hole and two flathead screws placed in the rear two screw holes), and with the large door (c) (and 
with the Specular Reflectance Accessory).   
  
Screws/Pegs 
There are 4 holes in the interior cavity of the machine for screws.  With each accessory 
description it is stated what screws to put in which holes.  For all of the accessories discussed 
besides the 45º bounce accessory you will need the silver alignment pin in the front left screw 
hole.  All of the screw holes are gold in color, as seen by looking at the empty screw hole in Fig. 
4b.  Also shown in Fig. 4b are two flathead black screws in the rear two holes. Also, between the 
holes is shallow rectangular depression.  At the front of this cavity is a 16 pin plug.   
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Taming the Beast Part V: 
The Scan Function 
 
I have mentioned that for all four of the accessories you will probably be using the Scan 
function, but I did not go into any great detail about the function itself and made several 
assumptions about knowledge of the menus.  Here I will go over the Scan Function in more 
detail, and less specifically to any one accessory than I did in the Accessory section.   
 The purpose of the scan function is for the machine to emit light and read how much it 
receives back over a range of wavelengths.  We use this function because astronomy is a science 
where knowing what happens at different wavelengths due to the effects of the instrument is 
important.   
 In the “Setup…” menu (which you can get to either by clicking on the “Setup…” button 
to the left of the page or by clicking on “Setup…” in the toolbar) there are nine tabs.  These are: 
Cary, Options, Baseline, Accessories 1, Accessories 2, Accessories 3, Samplers, Reports, and 
Auto Store.  If you are looking at a tab and need help, click on the “Help” button at the bottom, 
and you will be taken to the Varian Help page for that tab.  Their page is more helpful than I 
could be.  When there are checkboxes, the box that is checked shows the machines that the 
options are available on, and the red x’ed in box is the machines that the options are not available 
to.  This is a Cary 100.  You will not have any use for the Accessories or the Samplers tabs.  
While you are currently scanning, you cannot click “OK” in the Setup.  This just means that you 
can’t change the settings in the middle of the scan.  The zero and the baseline buttons on the 
main screen (once you are done with setup) are located below the “Setup…” button.  If you set 
up the Scan in the Baseline tab so that you will need a baseline, you will need to click the 
Baseline button to take the baseline (after properly setting up to do so).  If you set it up to use 
zero correction, as well, you will need to set it up properly to do so and then click on the “Zero” 
button.  If you have a setup that you will be using frequently, you can save the method (using 
“Save Method” in the file menu) to use again later.   
 A further note on the baseline is that if it turns out looking very strange, you may want to 
test with a sample you know the shape of to be sure that the baseline will not affect it.  If the 
baseline starts out very noisy, it’s a good indication that the baseline will be terrible.  If it is 
terrible, you need to restart the machine.  Examples of baselines can bee seen in Figure 12.   
 Farther down the screen are three more buttons.  The “Clear Report” button clears the 
current report.  The “Recalculate” button takes you to the Reports tab of the setup, and the 
“Print…” button opens a print setup window.  I believe this will print the report.    
 Across the top of the screen is the tool bar, with old friends like “File, Edit, View, and 
Help”, along with “Commands, Setup…, Graph, and Maths…”  As stated previously, clicking on 
“Setup…” will open the setup window.  The file menu will let you close, open, save, or print a 
file.  It is almost exactly like any other file menu from any other Windows application.  The edit 
menu is exactly like almost every other edit menu in Windows application, but it adds “Edit 
Report,” which I feel is a pretty self-explanatory command.  The View menu will let you select 
what to view.  If you select “Report Vertical” it won’t show the report unless you also select 

Figure 11: Screenshots of “the toolbar” (a), a disconnected scan window (b), and a scan 
window taking data (c).  

a 



17 

     
 
 
 
 
 
 
 
 
 
   b 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
   c 
 
 
 
 
 
 
 
 
 
 



18 

“Report”.  ADL is the programming language that can be used to help run the machine, details 
about it can be found online.  I highly recommend using the toolbar and buttons, since I mention 
them from time to time in this document.  The Help menu is also normal enough.   
 The Graph menu will open smaller menus unless you select copy graph or paste to graph.  
Most of the smaller menus appear in the toolbar above the graph.   The toolbar (shown in Fig. 
L(a)) has the following buttons (from left to right): Trace Preferences, Graph Preferences, Cursor 
Mode, Axes Scale…, Autoscale (XY), Autoscale (X), Autoscale (Y), Zoom Out, Add Label…, 
Add Picture…, Single/Multi Graph, Auto Arrange Graphs, Add Graph, Remove Graph, Clear 
All Traces, User Data Form…, Peak Labels…, and Maths….  “Trace Preferences” lets you 
choose the color for traces (by right clicking on a selected curve and going down to “change 
trace color”:), the names of the traces if you named them poorly when it first prompted you for a 
name (same as changing the color, but select “change trace name” instead of “change trace 
color”), select the “focused trace” (click on that row), delete the trace from the graph entirely 
(select the row, right click, and select “delete trace”), and view or not view the trace on the graph 
(click in the “Visible” column of that row to check or uncheck).  If you have more than one 
graph open, you can select traces to one graph and not to another.  The “Graph Preferences” lets 
you change the color of the axes, and the background.  It also lets you switch between different 
grid styles, styles of traces, and the number of tick marks on each axis.  “Cursor Mode” lets you 
switch between the cursor tracing the graph and just appearing where you have it.  “Axes 
Scale…” lets you specify the ranges for the axes, the format is “low - high” for both.  It will also 
let you select a few previously used ranges.  Clicking on “Autoscale (XY)” will set the range of 
both axes to fit the focused trace’s X domain and have a range for the Y values that will go to 
slightly above the largest y-value of the focused trace and slightly below the smallest y-value at 
the moment.  Clicking on “Autoscale (X)” will change the X-domain on the graph to exactly fit 
the graph’s x-values at the moment.  Clicking on “Autoscale (Y)” will change the Y-range to 
have a maximum slightly greater than the current y-maximum and a minimum slightly less than 
the current y-minimum.  Clicking on “Zoom Out” will change the ranges to those specified in the 
“Setup…” window.  “Add Label…” will let you add a label to the graph.  “Add Picture…” will 
allow you to paste a picture into the graph.  “Single/Multi Graph” will toggle between viewing 
all of the graphs and just the selected graph if you have more than one graph open in that 
window.  “Auto Arrange Graphs” will arrange the graphs in the way that it thinks is best.  “Add 
Graph” will add a blank graph to the file.  “Remove Graph” will remove the selected graph.  
“Clear All Traces” will hide all traces on the selected graph, and make the graph blank.  The 
traces will remain available in the “trace preferences” window/menu.  “User Data Form…” lets 
you add information into a form.  On the left there is the “trace name” column automatically.  If 
you want to add data, you will need to enter a column heading for the column, or it will not be 
saved.  Personally, I find it easier to save a text file in the same directory as the data with 
explanations.  “Peak Labels…” will let you label peaks in the graph.  There are up to two tabs in 
this window.  The first, “Peaks” lets you tell it what peak type you would like (Peaks, Valleys, 
Peaks and Valleys, or Zero Crossings.  You can determine how much above or below the other 
points it needs to be called a peak, and whether you want all the peaks labeled or only the 
maximum.  (Note: for %T graphs the valleys are peaks, and the peaks are valleys.)  The label 
type can be both the X and Y values, only the X value, or only the Y value.  It can also be “no 
labels”.  When “no labels” is selected the second tab to this window will not appear.  For all 
other label types there will be a second tab where you can format the label.  This tab is called 
Peak Label Details.  When you have selected to label either both X and Y or just Y, you can 
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decide how many Y decimals you want the label to carry out to.  You can format the font of the 
label by clicking on the button next to “Font”.  There is a picture to the right of those two 
options.  Below that picture is a slide bar.  There are four positions on that slide bar.  Moving the 
slider to a different position will put the label in a different position with respect to the peak 
itself, and the text in different orientations.  (You can change the position of the label without 
using this option by clicking on the label and then dragging the label to where you want it to go, 
but you cannot change the orientation except in this menu.)  “Maths…” will let you perform 
various mathematical operations to the selected trace.  Clicking the “Selected Trace” button will 
enter the name of the trace into the field.  Clicking the “Focused Trace” button will enter 
“Focused trace” into the field, and will act on whatever trace is currently selected.  Pushing other 
buttons will add functions outward.  You want to use the “Selected Trace” button when you are 
performing math with more than one function in the equation.  The “Focused Trace” is most 
useful when performing the same task to several different traces, but only using one trace in the 
operation.  The CE button will clear the last button clicked on, and the C button will clear 
everything in the field.  The Display options will let you either create a new graph and have the 
resulting function displayed there or create the new trace into only the trace preferences window.  
(The “selected graph” option)  The “Selected Graph” option requires that a graph be highlighted.   
 Next to the “Graph” pull down menu there is “Maths….”  Clicking on this will open the 
“Maths…” menu, just as it did when you clicked on it in the toolbar.   
 
Figure 12:  Not a terrible baseline, the blue line, you wouldn’t need to redo this one (a).  If you see this 
baseline, restart the Cary.  The red curves should look the same but the baseline has affected the data; the 
data should not have that problem (b). 

 
 
If you ever have any terrible problems that neither this nor the help files on the computer can 
help you with, call the 800-number that is on the business card which was taped to the machine 
on the right side.  The EL0404 number is the serial code.   
 


